
Google Docs Accessibility (A11y)



Building Accessible Google Docs

• Heading Styles 

• Table of Contents

• Columns and Lists

• Tab Stops

• Paragraph Spacing

• Meaningful Link Text

• Images 

• Captioning

• Tables

• Color Contrast

• Headers and Footers

• Accessibility Checker

A11y



What is Assistive Technology?
Assistive Technology (AT) are “products, equipment, and systems that enhance 

learning, working, and daily living for persons with disabilities.”

Screen Readers
Magnification 

Software
Speech 

Recognition Trackball Mouse Keyboard

Zoom Text Braille Computer Keyboard Captions/Subtitles Captioned 
Telephone Video Relay Services



Captioning Videos
Per federal and state law, and CSU policy, instructional media (e.g., 
videos, captured lectures, recorded presentations) must have captions. This 
includes instructional media used in classrooms, posted on websites or shared 
in Canvas.

• All students who are enrolled in a course must be able to access 

the content in the course.

• Faculty: Funding is available to help faculty generate captions and 

transcripts for instructional media. Materials should be 

submitted at least six weeks in advance of their use in instruction.

• Staff: For CSUN staff who do not provide classroom material, there 

is a cost through chargeback. For information on the chargeback, 

email ncod@csun.edu.

csun.edu/captioning

mailto:ncod@csun.edu
http://www.csun.edu/captioning


What are Screen Readers
Screen readers are a form of assistive technology (AT) software that 
enables access to a computer, and all the things a computer does, by 
attempting to identify and interpret what is being displayed on the 
computer screen using text-to-speech. Screen readers can only access and 
process live text (fully editable or selectable text).

• Provides access to someone who is 
visually impaired, mobility or has a 
learning disability to access text on the 
screen.

• Offers same level of independence and 
privacy as anyone else.



Types of screen readers

Screen reader program for 
Microsoft Windows that allows 
blind and visually impaired 
users to read the screen either 
with a text-to-speech output or 
by a refreshable Braille display. 
NVDA screen reader can be 
downloaded free of charge by 
anyone.

Provides auditory 
descriptions of each 
onscreen element 
using gestures, a 
keyboard, or a braille 
display.

Adds spoken, audible, 
and vibration feedback 
to your device.

Screen magnifier for 
Microsoft Windows 
that allows you to see 
and hear everything on 
the computer.

https://www.nvaccess.org/


How Do Screen Readers Work?
• Screen readers read line-by-line from left-to-right 

and top-to-bottom. 

• Screen readers start at the top of a document or 
website and read any text including alternative text 
for images, graphics or charts. 

• Screen readers navigate a document or website 
using the keyboard without a mouse. Tab key: jump 
from link to link, Enter: select a link, arrow keys: 
navigate a document or website.

• Reading order is important for users with visual 
challenges. The users can become confused if the 
document (content, tables, images or charts) is 
poorly organized or out of order.



Click vs Select

Screen readers and physical or mobility limitation 
users navigate a document or website using the 
keyboard without a mouse. The word “Click” is not 
inclusive of people who can’t use the mouse. Use the 
word “Select” to write step-by-step instructions.

“Click” or “Click on” Example

• Go to YouTube video player

• Click on Settings gear icon

• Click on Subtitles/CC

• Click on Options to Customize

• Click on Caption Style

Use “Select” Example (Recommend)

• Go to YouTube video player

• Select Settings gear icon

• Select Subtitles/CC

• Select Options to Customize

• Select Caption Style



Digital Accessibility Content Analogy

Organize content with headings, subheadings, images, videos, and footer 
are important for usability and accessibility.



Readability

• Divide large blocks of text into smaller sections

• Avoid overly complex sentences

• Provide adequate whitespace

• Use line or paragraph spacing (avoid Enter/Return for 
“blank” space)

• Avoid underlining text. Underlining is interpreted by screen 
readers and people with low vision as linked text. 

• Font size between 12 to 18 point

• San-serif fonts are more suited to electronic formats (Arial, 
Calibri, Verdana or Franklin Gothic Book)

• Capitalization for the heading is fine not the entire 
paragraph. Most people have difficult to read it if all text 
capitalized.



Mysterious Dash or Hyphen
Screen readers do not know what the – symbol represents (minus, hyphen, en dash or em dash) 

so screen readers will not read it. It is always a good practice to spell the word and spell out any 

abbreviations or make a reference to your abbreviation when used for the first time. 

For example:

• May 8th, 2022 from 3:30 - 5:00pm. The screen reader reads three, thirty five. Recommend 
May 8th, 2022 from 3:30 to 5:00pm.

• Final exams May 14 - 20, 2022, screen reader reads May 1420, 2022. Recommend 
May 14 to 20, 2022.

• Homework assignment pages 200 – 281 for tonight’s reading material. Recommend 
pages 200 to 281. 

• The fiscal year 2015-2016. Recommend The fiscal year from 2015 to 2016.

• Grading scale 95 - 100%, screen reader reads 95100%. Recommend 95 to 100%. 
❖A + , screen reader reads A+. Recommend A plus.

❖A – , screen reader reads A. Recommend A minus.

❖ Recommend to spell the word plus or minus for consistency purpose.



Styles vs Direct Formatting

Styles Formatting
• Provide structure and make document accessible

• Easier to modify existing formatting

• Create and update a Table of Contents

• Quicker navigation to different sections in a document

• Retain document structure when export to PDF

• Accessible to any assistive technology like screen 
readers

• Save time and save lives!

Direct Formatting

• Not accessible to any assistive 
technology such as screen readers

• Can’t create a Table of Contents

• Can’t create navigation to different 
sections in a document

• Huge barriers!



Headings and 
Document Structure

Example 1: Reading long, dense text 
documents can be a daunting task for 
learners

Example 2: Well-structured documents help readers 
organize and process texts



Headings Structure Example

Before Adding Headings

Item titles are bold at the start of each line

Course: ENGL 315

Title: Digital Writing

Class #: 15275

Days: TuTh

Instructor: Jane Doe

Email: jane.doe@csun.edu

Office: Sierra Hall 300

Phone: 818-677-9999

Adding Headings

Text with section titles added with headings

Course Info (Heading)
Course: ENGL 315
Title: Digital Writing
Class #: 15275
Days: TuTh

Instructor Info (Heading)
Instructor: Jane Doe
Email: jane.doe@csun.edu
Office: Sierra Hall 300
Phone: 818-677-9999

mailto:jane.doe@csun.edu
mailto:jane.doe@csun.edu


Heading Styles
Heading Styles (Heading 1 through Heading 6) in a logical 
sequence. Do not skip heading levels i.e. Heading 2 to Heading 4, 
headings should be in order.)

• Heading 1: Document title or main content heading/title (just 
one)

• Heading 2: Major section heading

• Heading 3: Sub-section of the Heading 2

• Heading 4: Sub-section of the Heading 3, and so on, ending 
with Heading 6

• Normal: Text or Paragraph

Using heading styles means you can also quickly build a Table of Contents, 
reorganize your document, and reformat its design without having to 
manually change each heading's text.

Headings are styles to give a document structure by category or topic. 

Without headings, a person using assistive technology like a screen reader cannot navigate by 
sections, subsections, or scan section titles to understand the document structure. 



Heading and Paragraph
Avoid making the heading style and paragraph in one section because it would cause the Table of Contents 
to automatically populate the long list of titles.

Make sure the heading style is listed on a single line and add the main content below the heading style in 
a normal paragraph.



Heading Styles compatible with other programs
Google Docs

Canvas

InDesign Website



Heading 1 – Update ‘Heading 1’ to match

Unlike Microsoft Word, to modify 
headings, Direct Formatting and Styles 
must be used. For example, Heading 1

1. Highlight heading title text

2. Select preferred font, color, and 
size

3. Select Heading 1 then Update 
‘Heading 1’ to match

4. Repeat steps for Heading 2 through 
6 if needed



Heading 2 – Update ‘Heading 2’ to match

Repeat for Heading 3 
Sub-section Titles, etc.



Apply Heading 2

• Highlight heading title text “What is 
Accessibility? What is Universal 
Design?”

• Open Styles menu

• Select Heading 2

• Select Apply Heading 2

• This will retain the same Heading 2 
structure

• Repeat same steps to apply more 
Heading 2 in the document



Heading Styles with Border Line

1. Select Heading 2 title

2. Format > Paragraph Styles > 
Borders and Shading

3. Adjust preferences for your border 

4. Select Update ‘Heading 2’ to 
match



Heading Styles with Background Color

1. Select Heading 2 title

2. Format > Paragraph Styles > 
Borders and Shading

3. Adjust preferences for your border 

4. Select Update ‘Heading 2’ to 
match



Document Outline
The quickest way to check a document’s heading structure is to open View tab, 
select Show Document Outline 



Automatic Table of Contents

Heading 1

Heading 2………………………………1

Heading 3……………………..3

Heading 2………………………………8

Heading 3…………………….10

Heading 3…………………….12

Heading 3…………………….16

Heading 3…………………….18

Heading 2……………………………..19

Heading 2……………………………..53



Table of Contents
• Headings structure will automatically populate a table of contents and provide 

accessible for screen readers rely on headings structure to navigate a page quickly. 

• Adding Table of Contents to any documents or syllabus over 8 pages to make it 
easier for readers to go directly to a specific section in the document.

• Insert > Table of Contents > Select with page numbers



Lists

• Use the bulleted or 
numbered list 
formatting tool.

• Screen readers can 
read the number of 
items in a list 
before it begins to 
read the items.



Columns, 1 of 2
• If you want to make columns, format them as columns. Screen readers can read the 

content organized in columns.

• Do not put text on one line and use several tab stops to move it over. Screen readers 
will read it one line a time, not as columns. 

Optional: If you want to add line between the 
columns, select More Columns, checkbox Line 
Between.



Columns, 2 of 2
Unlike Word, the columns are not automatically set up. 

• First, put the cursor below the first list, select Insert, Break, Column Break.

• Repeat until you have all your columns set.



Use Page Break, 1 of 2

Screen readers can read blank characters 
as “Blank”. This can be very irritating, 
especially if there are multiple blank 
characters.

With your Google Docs opened

• Select Add-ons tab, then select Manage 
add-ons

• Search Show and Install Show

• Select Add-ons, Show, Show All paragraph 
marks. Select Hide all to hide paragraph 
marks.



Use Page Break, 2 of 2

1. Put your cursor where 
you want one page to 
end and the next page 
to begin

2. Go to Insert > Page 
Break

3. See link for in depth 
information: Page 
breaks for cleaner 
documents

https://www.upcurvecloud.com/blog/how-to-become-a-formatting-master-with-google-docs/


Tab Stops

To create three columns in one line, set Tab 
Stops.

1. View tab then Show Ruler

2. Highlight the selected text

3. Place mouse cursor on the ruler at 2.5” then 
select “Add left tab-stop”

4. Place mouse cursor on the ruler at 4.5” then 
select “Add left tab-stop”

Note: You can also set indentation in lieu of a 
single tab-stop.



Paragraph or Line
Spacing

• Avoid creating blank lines to create 
spaces between text. 

• Use line or paragraph space to 
increase or decrease the amount of 
space between headings and 
paragraphs.

• Heading levels space between a 
heading and the previous section’s 
body text.



Paragraph Spacing
• Select one or more paragraphs to update paragraph spacing

• Format > Line Spacing > Custom spacing

• Paragraph spacing, you will need to experiment in order to get the desired spacing.

• Repeat the same steps above if you’d like to add spacing for Heading Styles then select 
Update “Heading” to match.



Descriptive Link Text, 1 of 2
Not Accessible – vague and redundant

CSUN News

CSUN Honors Four Exceptional Graduate Students for Thesis and Project Work

CSUN’s Division of Academic Affairs has selected four exceptional CSUN graduate 
students as the winners of the 2020 Distinguished Thesis/Graduate Project 
Competition, with each receiving a $1,000 award and recognition from the 
university. Read more.

CSUN Team to Tap into Power of Inouye Telescope to Study Sun’s Atmosphere

With the aid of a telescope in Hawaii, a team of professors at California State 
University, Northridge hope to solve some of the mysteries found in the sun’s 
atmosphere, information that could help us better understand the impact of solar 
flares, as well as what is happening with other stars in our solar system.
Read more.

Minimizing the COVID Slide During the Summer

In response to the COVID-19 pandemic, schools across the nation transitioned to 
meeting online. Given the abruptness of the transition and lack of preparation 
parents had in becoming in-home teachers’ aides, many parents and educators 
are worried about a “COVID slide” or “COVID slowdown,” where students fail to 
retain any new information learned before and during the pandemic — as well as 
over the summer, when students are not in school.
Click here

Screen readers read: "Read more, link" "Read more, link" "Click here, link"

Accessible – descriptive and unique
CSUN News

CSUN Honors Four Exceptional Graduate Students for Thesis and Project Work

CSUN’s Division of Academic Affairs has selected four exceptional CSUN graduate 
students as the winners of the 2020 Distinguished Thesis/Graduate Project 
Competition, with each receiving a $1,000 award and recognition from the 
university. Learn more about CSUN's Four Exceptional Graduate Students.

CSUN Team to Tap into Power of Inouye Telescope to Study Sun’s Atmosphere

With the aid of a telescope in Hawaii, a team of professors at California State 
University, Northridge hope to solve some of the mysteries found in the sun’s 
atmosphere, information that could help us better understand the impact of 
solar flares, as well as what is happening with other stars in our solar system.
Continue reading about CSUN's Astronomy Team.

Minimizing the COVID Slide During the Summer

In response to the COVID-19 pandemic, schools across the nation transitioned to 
meeting online. Given the abruptness of the transition and lack of preparation 
parents had in becoming in-home teachers’ aides, many parents and educators 
are worried about a “COVID slide” or “COVID slowdown,” where students fail to 
retain any new information learned before and during the pandemic — as well 
as over the summer, when students are not in school.
Learn more about the "COVID Slide".

Screen readers read: The content and link text then announce the word "link"

Full URL text https://www.csun.edu/universal-design-center
(raw URL may not make sense to screen reader users or others, so make the link text descriptive i.e. Universal Design Center)

https://csunshinetoday.csun.edu/university-news/csun-honors-four-exceptional-graduate-students-for-thesis-and-project-work/
https://csunshinetoday.csun.edu/csun-leaders/csun-team-to-tap-into-power-of-inouye-telescope-to-study-suns-atmosphere/
https://csunshinetoday.csun.edu/csun-leaders/minimizing-the-covid-slide-during-the-summer/
https://csunshinetoday.csun.edu/university-news/csun-honors-four-exceptional-graduate-students-for-thesis-and-project-work/
https://csunshinetoday.csun.edu/csun-leaders/csun-team-to-tap-into-power-of-inouye-telescope-to-study-suns-atmosphere/
https://csunshinetoday.csun.edu/csun-leaders/minimizing-the-covid-slide-during-the-summer/
https://www.csun.edu/universal-design-center
https://www.csun.edu/universal-design-center


Descriptive Link Text, 2 of 2

A presentation that is intended to be displayed electronically and in a printout, include the URL 
and a description in the link text. For example, “Universal Design Center (www.csun.edu/universal-
design-center).”



Best Practices for Accessible Links

DESCRIPTION

• Link text must always properly 
describe the purpose of the link 
and tell a user where the link will 
take them. 

• Do not use text such as “click 
here” or “read more,” nor web 
addresses (URLs).

PRESENTATION

• Each link on the page should 
be visually different from 
regular text on the website.

• Can be differentiated by color, 
bold, underline, or italics.

•Using color alone does not 
make it accessible.

FUNCTIONALITY

• Link functionality is about 
ensuring a link functions the way 
the user expects.

• Links must always enhance the 
accessibility of a webpage.

• Users must be able to access 
links using a mouse, keyboard, or 
speech recognition commands.

LINKED IMAGES

• A linked image is an image (with or without text) that is linked to another resource or webpage. 

• Linked images need link descriptions as well as image descriptions (alt text).

• If the link description is different than the alt text, enter the link description in the HTML Title field. 

• Visit Linked Images on the Best Practices for Accessible Images page for more information.

https://www.csun.edu/universal-design-center/best-practices-accessible-images#LinkedImages


Visual Challenge

Normal vision Low vision Color blindness Blind or deaf-blind

What’s the best way to make images 
accessible to everyone?



Image Alternative 
or Alt Text

Screen readers and other AT announce that it’s 
an “image” or “graphic”,  then read the alt text:
“Three plants going through transformation 
with text quote Accessibility user-friendly 
document for CSUN student success.”

• The purpose of Alt Text is to allow low vision or blind users who 
use text-to-speech assistive technologies (AT), such as screen 
readers, to understand the purpose of graphic images. Sighted 
users usually don’t see alt text unless they use AT.

• Screen readers and other AT can’t convert images into texts. So, 
when writing alt text, consider the following for images:

o Describe the content and the purpose of the image clearly 
and concisely, in a phrase or a sentence or two. Keep alt text 
short 200 characters or less. 

o Image with text (for example, the CSUN wordmark) should 
include the words on the image. 

o “Image of…”, “Photo of…” is not needed because screen 
readers and other AT announce that it’s an “image” or 
“graphic”.

o When completing the alt text, use proper punctuation such 
as periods to indicate the end of the alt text. Without proper 
punctuation, some screen readers will run the alt text into 
the body text that follows and cause confusion to the user.

o Don’t insert hyperlinks in alt text because they are not 
clickable and can’t create descriptive link text.



How to Describe Images?

A stair chase leading up to an entryway is 
painted yellow with bold black text that reads 

museums are now.

A hand reaches out of a computer screen giving 
the hand gesture for stop. The screen reads 

‘access denied!’

On the left is the book cover for Haben The Deafblind 
Woman Who Conquered Harvard Law, and on the 

right is the quote: “In the Tigrinya language of Eritrea 
and Ethiopia, Haben means 'pride.’”

Michelle Obama claps and Barack waves.
Student holds a diploma hardcover up in the air 
during CSUN commencement. Caption text "and 
together, as Matadors, we will move mountains."

More examples of How 
to Describe Images

• Document Learning Tools: Describing images

• How to Describe Images (Art, Chemistry, 
Diagrams, Flow Charts, Formatting & Layout, 
Graphs, Maps, Mathematics, Page Layout, Tables, 
Text-only images)

• Periodic Table of the Elements

• UDC Best Practices for Describing Images

https://www.csun.edu/universal-design-center/document-learning-tools#DescribingImages
https://poet.diagramcenter.org/how.html
https://cdpn.io/aardrian/debug/NmoQdN
https://www.csun.edu/universal-design-center/best-practices-accessible-images


Google Docs - Adding Alt Text

1. Select an image, drawing, 
or graphic.

2. Right click > Alt Text.

3. Add the alt text in the 
Description field.

4. Select OK.



What are Decorative Images?
• Conveys no information; does not provide 

meaningful information.
• Purely for visual effect.
• The horizontal line that divided the two sections.
• Line border image used as part of page design.
• Decorative images do not require a text alternative.
• Decorative images, lines, borders, or shapes ignore 

by assistive technologies, such as screen readers.



Image Position
Text wrapping around an image, screen readers will skip it. To ensure 
screen readers do not skip over an image, the image needs to be on its 
own line “InLine with Text”.



Images.
• At times alternative text and caption 

are not the most appropriate method 
to describe an image. As such, the 
description of the image can be 
conveyed within the surrounding body 
of the text. 

• If you do this, include the words “In 
the image above”, “..below”, etc. that 
way the user knows you are 
describing the image that did not have 
alt text and caption within the 
paragraph. 

One of Australia’s most remarkable natural gifts, the 
Great Barrier Reef (shown in the image above) is 
blessed with the breathtaking beauty of the world’s 
largest coral reef. The Reef contains an abundance of 
marine life and comprises of over 3000 individual reef 
systems and coral cays and literally hundreds of 
picturesque tropical islands with some of the worlds 
most beautiful sun-soaked, golden beaches. 



Complex Images

Some images, such as graphs, charts or informative 
illustrations require fairly lengthy explanations to make 
them accessible. When this is the case, there are a few 
options:

1. Provide a brief alt text description of the image and 
a longer description within the text of the 
document. This may be helpful for others as well 
since some people have difficulty understanding 
charts and graphs.

2. Provide a brief alt text description of the image and 
create a section at the end of the document for long 
descriptions.

3. Provide a brief alt text description of the image and 
create a separate document with a long description 
of the image.

Credit to Explore Access 

Example of Option 1

Chart 1. Website Accessibility Assessment of All Organizational Charts. 
Findings from the assessment indicate the following: 5% of 
organizational websites had fewer than 2 errors on the home page; 20% 
had 3 to 5 errors; 45% had 6 to 10 errors; and 30% had more than 10 
errors on the home page.

http://exploreaccess.org/creating-accessible-documents/creating-accessible-ms-word-documents/


Provide descriptions if using color to convey meaning

Example 1: Inaccessible color highlights in red

May 11 to 17, 2019

Example 1: Accessible with a description

May 11 to 17, 2019* (final exams)

Example 2: Inaccessible table

Example 2: Accessible table

Example 3: Inaccessible color shape

Color identical may not 
be recognized by 
colorblind users

Example 3: Accessible color 
and number



Check Color Contrast

People who have low vision or 
colorblind could encounter some 
difficulty distinguishing text color 
from a background color if the 
contrast is insufficient contrast ratio 
1.5:1. 

This example has a great color 
contrast ratio of 8.7:1. The 
contrast is sufficient for those 
who have color deficiencies

• Download Colour Contrast Analyser onto 
your computer (PC/Mac) to ensure 
accessible contrast or use an online 
contrast checker from WebAIM.

• WCAG Level AA requires a contrast ratio of 
at least 4.5:1 for regular sized text (12 or 
14 pt. font) and 3:1 for large text (18 pt. 
font).

• Coblis Color Blindness Simulator

https://www.csun.edu/universal-design-center/document-learning-tools#ColorContrast
https://webaim.org/resources/contrastchecker/
http://www.color-blindness.com/coblis-color-blindness-simulator/


Tips for Creating Accessible Tables

Use Google Docs’ built-in 
to create Tables

• Create tables by inserting them. Avoid creating tables by 
drawing boxes and lines or by using tabs and spaces. 
Screen readers have difficulty understanding tables with 
odd cell sizes.

• Simple Data Tables only. 

• Screen readers read tables from left to right, top to 
bottom, one cell at a time. 

Keep your table simple
• Simple tables are easier to interpret for all 

students and screen readers.

• Avoid merging cells, split cells, no blank cells, as 
well as tables nested within a cell. 

• Use tables to organize data not format 
information. Never use table for layout.

• The complex a table (merging cells, nesting 
multiple headings under one, adding blank lines, 
etc.) the worse it will be for accessibility.

• Sample of Simple Tables vs. Complex Tables by 
Penn State.

http://accessibility.psu.edu/tables/


Accessible grading scale in table vs non-table format
Non-table format

A plus = 1000 to 970 points

A = 969 to 940 points

A minus = 939 to 900 points

B plus = 899 to 870 points

B = 869 to 840 points

B minus = 839 to 800 points

C plus = 799 to 770 points

C = 769 to 740 points

C minus = 739 to 700 points

D plus = 699 to 670 points

D = 669 to 512 points

D minus = 639 to 600 points

F = 599 points or lower

Table format

Different screen readers may read texts differently. The “+/-“ may not be 

read out loud. Screen readers will read + symbol for plus but not - symbol. 
Screen readers do not know whether - symbol is minus, hyphen, dash, en
dash or em dash. It is always a good practice to spell them out and spell out 
any abbreviations or make a reference to your abbreviation when used for 
the first time. Visit Screen Readers: A Guide to Punctuation and Typographic 
Symbols.

https://www.deque.com/blog/dont-screen-readers-read-whats-screen-part-1-punctuation-typographic-symbols/


Use Tables for Data
Use tables for presenting data, not for changing the visual layout of the page. In the table, include a 

heading row (rather than starting with data in the first row) because screen readers automatically 

read the first row as a heading row. 

• Select Insert tab, then select Table.

• Select the number of rows and columns by highlighting the boxes on the grid.

• Right-click to select Table Properties to adjust color, dimensions, or alignment.



Table Color
Avoid using color as the only means to convey information. For example, in the 
table below, the complete and incomplete items may appear the same to 
someone who is color blind:

A better option would be to provide another way of conveying information not 
just color alone:



Headers and Footers

Q: Should I included headers and footers in my document?

A: Headers and Footers are not always read immediately to 

screen reader users. However, if a screen reader user wants 

to look at the header there are methods for them to do 

that. 

Headers and Footers can be used to hold document 

information but should never hold important document 

content such as filename, document owner etc.

Select Insert tab, select Headers & Footers



Accessibility Checker for Google Docs

There isn’t a complementary service provided by Google to do an 
accessibility check. However, there is Grackle Docs, which is an Add-ons 
that extends the accessibility of Google Docs by automatically checking all 
aspects of your document and advising you how to make things better. 
Grackle Docs is free for 30 days. Learn more about Grackle Docs.

https://www.grackledocs.com/grackle-docs-one-click-accessibility-google-docs/


Alternative to download Google Docs to Word

• The most reliable method for creating a PDF from 
a Google Doc document is to first export it as an 
MS Word document, then convert the Word 
document into a PDF. This will preserve the 
majority of formatting elements that are present 
within the Word document.

• File > Download > Microsoft Word (.docx)

• Microsoft Office is available for free to all CSUN 
faculty, staff and students. Faculty and staff may 
also use Office Online or install Office on their 
personal devices.

https://www.csun.edu/it/microsoft-office


Word Accessibility Checker

• Word 365: Select Review tab, select Check 
Accessibility

• Word 2016: Select File menu, then Check for 
Issues and select the Check Accessibility from 
the drop-down menu.

The accessibility checker will identify 
certain accessibility issues:

• Headings that are not in logical 
order

• Images with no alt text

• Tables have the header box checked

• Tables that have merged cells or 
with empty cells

• Large numbers of repeated blank 
characters (spacebars, tabs, enters)



Check for Issues, Check Accessibility
Always use Word’s built-in Accessibility Checker

Repair Errors, Warnings and Tips



How to add a document title?

A document title is a descriptive and meaningful version of the file name. When converting to PDF, titles are 
often visible in the PDF window or tab. Well defined PDF titles can help students assess the content of a 
document. This quick assessment helps students save time deciding which documents to engage with. The best 
way to add a PDF title is to edit an original document such as Microsoft Office file.

1. Open Microsoft Word

2. Select File from the menu and 
select Info tab

3. In the Properties section, select Add a 
Title field to add a document title.

4. A title is a short descriptive sentence of 
what the document is about. For example, 
file name ‘Accessible Tables.doc’ versus the 
title ‘Guide for Creating Accessible Tables’.

5. Save the changes you made.



Windows: Converting a document to PDF

1. Select File from the menu and 
select Save As. Choose where you 
want to save the file.

2. In the Save As dialog box, 
choose PDF in the Save as type list.

3. Select Options button in the same 
dialog box, make sure to select these 
boxes
• Document structure tags for 

accessibility

• Document Properties

• Create bookmarks using: Headings

4. Select OK and Save the PDF.



Mac: Converting a document to PDF

1. Select File from the menu and 
select Save As. Choose where you 
want to save the file.

2. In the Save As dialog box, 
choose PDF (Export Formats) in the 
File Format.

3. Select 1st radio button “Best for 
electronic distribution and 
accessibility (Uses Microsoft online 
service)“

4. Select Export button



Never Choose Print to PDF Option

Never choose a "Print" to PDF option in 
Office, or in any other program. A screen 
reader user may still be able to access the 
text of a PDF created in this way, but 
heading structure, alternative text, a logical 
reading order, and any other tag structure 
will be lost.

Use Save As choose PDF.



Open PDF files from Adobe Acrobat not Web Browser by default

Windows
• Save PDF files on desktop

• Right-click on PDF file, select 
Open with, Choose another app

Mac
• Save PDF files on Desktop

• Select PDF (not double 
click)

• File tab, Always Open 
with, Other



Adobe Creative Cloud for Faculty & Staff

• Adobe Creative Cloud software is now available for use (at no 
additional charge) on all faculty and staff university-owned 
computers, labs and classroom devices, and for all students. 

• Please note that this deployment of Adobe software is not 
available for use on personally-owned faculty and staff 
devices at this time.

• Learn more about Adobe Creative Cloud for Faculty & Staff

• Adobe Reader is for viewing, printing, signing, sharing, and 
annotating PDFs. Adobe Reader doesn’t have Accessibility 
checking tool.Adobe Acrobat DC

https://www.csun.edu/it/adobe-creative-cloud-faculty-staff


Create with Accessibility in Mind
Best Practices

Document Accessibility

user-friendly document for CSUN student success



How can we help you make a difference?

Universal Design means design for everyone

Universal Design Center Offers
• Online, self-paced training

• In-person training each semester

• Consultations

• Tools and Services
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